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Adobe Photoshop 
CS6.1 update
Welcome to the Adobe Photoshop CS6.1 bulletin update. This is 
provided free for readers of my book in order to keep everyone 
up-to-date with the latest changes to the Photoshop CS6 program. 
The CS6.1 update contains a number of new features and workflow 
improvements, but is available to Creative Cloud subscribers only. 
The idea here is that if you subscribe to the cloud as a single-
product or full Creative Suite user you will be entitled to this and 
any subsequent updates, all as part of the cloud service. At this 
point I imagine that the features that are added gradually to the 
CS6 program as updates will eventually form the next full product 
release. Overall, it seems that Adobe are in the process of switching 
to incremental updates on a more regular basis. Also, the timing of 
the announcement looks like it is intended to coincide with the cut-
off point for those with older versions of Photoshop to upgrade to 
becoming Cloud subscribers.
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Camera Raw
OK, this first part on Camera Raw isn’t such hot news, but is 
something that was announced earlier in 2012 and not exclusive 
to Cloud subscribers. But the Camera Raw 7.1 update saw the 
introduction of a couple of important new features.

Processing HDR files in Camera Raw
Camera Raw 7.1 or later now gives you the ability to edit TIFF 32-bit 
HDR files just as you would a regular TIFF or raw image. What this 
means is that you can now use the develop controls in Camera Raw 
or Lightroom to edit 32-bit HDR files (providing they have been 
saved as flattened TIFFs). If you have got accustomed to working 
with the latest Process 2012 tone controls, your editing experience 
working on HDR images will not be that much different from when 
working with regular raw, TIFF or JPEG images, except the dynamic 
range you’ll have to work with will potentially be that much greater. 
In my view, working with the Camera Raw tone adjustments makes 
it easier to achieve the desired tone balance in an image. The other 
benefit is that if you use Camera Raw as an HDR editor you won’t 
end up with the rather obvious ‘HDR look’ that you tend to get 
when processing HDR files to render low dynamic range versions. 
i.e. you can avoid getting the rather obvious halos (although some 
photographers do seem to like this kind of effect).

1 To begin with I needed to create an HDR file. For this example I opened three photos 
that were shot around two stops apart, where the camera was set to aperture priority 
mode and the shutter speed only was adjusted with each bracket. This ensured that the 
aperture and depth of field would be consistent for each exposure. To get even better 
results, you may want to shoot a 5-bracket sequence 

Camera Raw movies

Note that at around the time when Camera 
Raw 7.1 was announced I added a couple 
of movies to the book website. These 
show the two main Camera Raw features 
discussed here in use.
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2 Before creating a merged HDR image I find it helps to disable sharpening of the 
raw master files. To do this, I went to the Detail panel and set the sharpening Amount 
slider to zero. Having done this, I selected all three of the photos I was going to merge 
and synchronized the Detail panel settings.

3 In Bridge I went to the Tools menu and chose Photoshop > Merge to HDR Pro… 
This opened all three images, blended them together and presented the Photoshop 
Merge to HDR Pro dialog shown here. You can use this dialog to tone map and render 
an 8-bit or 16-bit image from the 32-bit HDR data, but here I selected the 32-bit 
option to keep the image in 32-bit mode.
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4 Here is how the 32-bit file appeared when viewed in Photoshop. It didn’t look that 
great at this point. This was because it was a high dynamic range master and the 
Photoshop preview could only show one segment of the overall image file exposure 
range (you can if you like, select the 32-bit Exposure slider option from the document 
window status bar to adjust the preview exposure). At this point I chose File ➯ Save 
to save the image as a TIFF.

5 Here is how the saved image looked when previewed in Camera Raw where zero 
settings were applied by default.
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6 I then used the Basic panel controls to edit the tones. Here, I adjusted the Contrast, 
Highlights and Shadows sliders to balance the tones better. I also adjusted the Whites 
and Blacks to fine-tune the end clipping points. I also applied a large amount of 
Clarity (which is usually necessary with 32-bit images like this) and increased the 
Vibrance.

7 In this final version I went to the Detail panel and edited the Sharpening sliders to 
apply the desired capture sharpening. Remember, I had disabled the sharpening prior 
to creating the original HDR master file, so it was necessary here to apply the desired 
capture sharpening to the image, just as one would to a regular raw master file. I 
did also carry out a few further modifications to the Tone Curve and HSL panels to 
achieve the final result shown here.
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Lens Corrections: Color tab
The Lens Corrections tab now contains a Color tab, which can 
be used specifically for making color lens corrections to do with 
color fringing (Figure 1). In particular, the new Defringe controls are 
designed to fix axial (longitudinal) chromatic aberrations. These can 
be caused due to ghosting, lens flare, charge leakage (which affects 
some CCD sensors) as well as color aberrations.
 Unlike lateral chromatic aberration, which occurs towards the 
edges of the frame, these types of aberrations can appear anywhere 
in an image. It particularly affects fast, wide aperture lenses and is 
typically most noticeable when shooting at the widest lens apertures, 
where fringes will usually be at their most visible just in front of and 
just behind the plane of focus. These will typically appear purple/
magenta when they’re in front of the plane of focus, and appear 
green when they’re behind the plane of focus. But even at the exact 
point of focus you may sometimes see purple fringes (especially 
along high contrast or backlit edges), which can be caused be flare. 
As you stop down a lens these types of aberrations are usually less 
noticeable.

The Lens Corrections panel
You will notice that the ‘Remove Chromatic Aberration’ check box 
which used to be in the Profile section has now been placed in the 
new Color tab section. Below that is the Defringe section, which 
consists of four sliders. There are now Purple Amount and Green 
Amount sliders for controlling the degree of correction and below 
each of these are Purple Hue and Green Hue sliders, which have 
split slider controls.
 So, if we look at the two Purple sliders, the Purple Amount slider 
has a range of 0–20 and is used to determine the strength of the 
purple fringing removal. The Purple Hue slider can then be used to 
fine-tune the range of purple colors that are to be affected. What 
you need to be aware of here is that higher Purple Amount settings 
will apply a stronger correction, but the downside is that at higher 
settings this may cause purple colors in the image that are not the 
result of fringing to become affected also by the Purple Amount 
adjustment. So, to moderate this undesired effect you can tweak the 
Purple Hue slider split points to narrow or realign the purple range 
of colors to be targeted.  You can drag on either of the knobs one at 
a time, or you can click and drag on the central bar to align the Hue 
selection to a different portion of the purple color spectrum. If you 
need to reset these sliders then just double-click on each individual 
knob. Likewise, double-click the central bar to reset this to it’s default 

Figure 1 The Lens Corrections dialog 
showing the new Color tab controls in 
Camera Raw 7.1 or later.
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position. The minimum distance that may be set between the two 
sliders is 10 units.
 The Green Amount and Green Hue sliders work in exactly the 
same fashion as the Purple sliders, except these two sliders allow 
you to control the green fringes. However, the default range for the 
Green Hue slider has a narrower range of 40 to 60 instead of 30 to 
70. The reason for this is to help protect common green and yellow 
colors such as foliage colors.

The Defringe controls in use
The recommended approach is to carry out all your major tone 
and color edits first. Then make sure that you have turned on the 
profile-based  lens corrections to correct for geometric distortion 
and vignetting. Once these steps have been taken, go to the Color 
tab of the Lens Corrections panel and check the ‘remove Chromatic 
Aberration’ check box. You can then start using the global Defringe 
sliders to remove any remaining signs of fringing. Be aware also that 
where the global controls are having an adverse effect on the rest 
of the image, you can always turn down the Purple/Green Amount 
sliders and use a localized adjustment with the Defringe slider set to 
a positive value to apply a stronger, localized adjustment. If carrying 
out a localized adjustment it is important to apply the geometric 
and any manual distortion controls first. As with the Detail panel 
controls, the Lens Correction defringe controls are best used when 
viewing an image at 100% or higher.
 You can also use the A key as a visualization aid. These can 
greatly help the user see an emphasized overlay that gives a clearer 
indication of what effect the sliders are having and making the most 
suitable slider adjustments.
 Use the A key to drag on the Purple Amount slider to visualize 
purple fringe removal. This will cause the preview to reveal only the 
affected areas of the image. All other areas will be shown as white. 
This lets you concentrate on the affected areas and help verify that 
the purple fringe color is being removed.
 Use the A key to drag on either of the Purple Hue slider 
knobs to visualize the range of hues that are to be defringed. As 
you do this, the preview will show the affected hue range as being 
blacked out. As you drag on a slider you need to pay close attention 
to the borders of the blacked out area to check if there are any 
residual purple colors showing still. Obviously, the same principles 
apply when adjusting the Green Amount and Green Hue sliders 
with the A key held down.
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Eyedropper tool mode
When working with the Defringe sliders you can hold down the 
C (Mac) L (PC) key as you roll the cursor over the preview 
window to reveal an eyedropper tool. This tool can be used to 
help set the Purple/Green Hue slider knobs. If the Caps Lock key is 
enabled, the eyedropper cursor will be shown as a cross hair. This 
can help you to pick the fringe pixels more accurately.
 To use this tool it helps to be zoomed in extra close, such as at 
200%, or even 400% . This will make the color picking more accurate 
and you will notice a little white bar appear on one or other color 
ramp as you hover the cursor over different parts of the image (see 
Figure 2). As you click in the preview this will allow Camera Raw to 
analyze the pixels in the local area around where you click, which 
can result in one of four outcomes. Camera Raw detects that you 
clicked on a purple fringe and will adjust the Purple Amount and 
Purple Hue sliders to suit. Alternatively, Camera Raw detects that 
you clicked on a green fringe and will adjust the Green Amount 
and Green Hue sliders. Or, Camera Raw determines that the area 
you clicked on was too neutral, or was a color that falls outside the 
supported color range and you will see one of the alert dialogs 
shown in Figure 3.

Localized adjustments: Defringe slider
The global Defringe controls should be all that you need in order 
to remove troublesome fringing. However, there may be instances 
where it won’t be possible to remove all visible fringing using the 
global Defringe sliders on their own. Or, it may be the case that 
when applying a strong global correction that the adjustment you 
apply has an adverse effect on other areas. In situations like this 
it may be useful to apply a global adjustment combined with a 
localized defringe correction using either the adjustment brush 
or graduated filter. Note that localized Defringe adjustments will 
remove fringes for all colors (not just purple and green) and 
therefore works independently from the global Purple Hue and 
Green Hue settings set in the lens Corrections panel.
 The global lens corrections are available for all process versions, 
but in order to apply a localized adjustment the image you are 
processing must be updated to the latest Process 2012. The standard 
range goes from -100 to +100. A positive Defringe adjustment can 
be used to apply extra defringing where required, such as when 
working on specific problem areas in a picture. It may even be the 
case that with some images a localized defringe adjustment is all that 
you need to apply.

Figure 2 This shows the Lens Corrections 
panel where the C (Mac) L (PC) key 
was held down. Here, you can see a white 
bar on the Purple Hue color ramp indicating 
where on the color ramp the sampled color 
lies. 

Figure 3 This shows the two possible error 
messages you might see when working with 
the eyedropper tool. The top one shows an 
alert pointing out that the sampled color 
is too neutral. The bottom alert dialog 
indicates that the sampled color falls outside 
the supported color range.
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 A negative Defringe adjustment can be used to say ‘don’t apply 
a defringe and protect this area’. One example of how you might 
want to use this would be to imagine a picture where say, a strong 
purple defringe was applied globally, which resulted in the edges of 
purple areas becoming desaturated. In a situation like this you could 
paint over the affected areas with the Defringe slider set to -100. 
This would allow you to restore the original color to these areas.
 It should be noted that the localized defringe control is not as 
powerful as the global defringe controls and cannot therefore be as 
effective as processing an image using the Lens Corrections panel. 
This is why it is often best to use the global controls first and then 
use a localized adjustment to fine-tune as necessary. A negative, -100 
defringe adjustment will of course completely remove any global 
defringing. Just be aware that there is therefore no benefit to be 
gained in applying multiple localized defringe adjustments to improve 
upon what a single application can achieve.

Applying a global Defringe adjustment

Defringe and Process Versions

As mentioned in the main text, the Defringe 
slider is only available as a localized 
adjustment when an image has been 
updated to Process 2012. You do need 
to watch out though that once an image 
has been updated to Process 2012 and a 
Defringe adjustment has been made that 
you don’t attempt to convert the image 
back to Process 2010 or Process 2003. 
If you do so this will cause the Defringe 
effect to be zeroed. The pin you added 
will still be present, but there will be no 
defringe adjustment. If you then convert 
the image back to Process 2012 the 
adjustment mask will be preserved and 
you can restore the Defringe effect by 
adjusting the Defringe slider setting.

1 The first step is to apply all the main color and tone adjustments as well as enable 
the lens profile corrections in the Lens Corrections Profile tab section.
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2 I clicked on the Color tab to view the color controls. It is usually best to simply check 
the Remove Chromatic Aberration option to auto correct the image. I then held down 
the A key and moused down on the Purple Amount slide to get a visualization of the 
extent of the purple fringed area, with everything else displayed white.

3 With the A key held down still I dragged the Purple Amount slider till all of the 
purple fringing seemed to have been removed. Note that it may often help to use a 
close-up view beyond 100% when judging the effectiveness of such an adjustment.
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4 Next, I wanted to concentrate on the Green fringing. Here, you can see the extent of 
the green fringes in the areas that were behind the plane of focus.

5 In this instance I decided to use the eyedropper mode to determine both the Green 
Amount and Green Hue slider settings. I held down the C (Mac) L (PC) key to 
change the cursor to an eyedropper and clicked on the green fringe area. This single 
step auto-set the Green Amount and Green Hue sliders.
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6 I held down the A key and moused down on the Green Hue ramp to obtain a 
visualization of the green hues and the extent they were being adjusted. However, there 
was no need to tweak the hue ramp sliders – the auto correction worked fine as it was.

1 This shows a close-up view of an image with noticeable fringes.

Applying a localized Defringe adjustment
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Fuji files
Fuji has developed a more complex matrix for its raw files. While 
a Bayer matrix is based on four units of  recurrence using RGGB 
(one red, two green and one blue photosite), the new Fuji matrix 
is based on 36 units of recurrence. Camera Raw 7.2 now supports 
the Fuji X-Trans sensor (which is found in the Fuji X-Pro1 and X-E1 
cameras).

2 With the image using Process 2012, I selected the adjustment brush, set the Defringe 
slider to +100 and painted over the affected areas to reduce the colored fringing. Using 
the adjustment brush in this way I was able to get rid of nearly all the visible fringing 
and target the Defringe adjustment precisely where it was needed most.
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Smart Object Support
Smart Objects (also known as Smart Filters) allow you to post-edit 
filter effects applied to a Smart Object layer. This can be done for 
most filters, but not all. The new CS6.1 update now provides Smart 
Object support for the Liquify and Blur Gallery filters.

Liquify
The reason why Liquify was not supported as a Smart Object 
was because the filter relied on the creation of a mesh, which was 
automatically deleted once you clicked OK to apply a mesh edit. 
Now, when a document or layer is converted to a Smart Object, 
Liquify saves a compressed mesh into the document. This means that 
when you choose to re-edit a Liquify filter setting the mesh can be 
reloaded. Note though that while the mesh is compressed, this will 
still cause documents to increase in size

Performance and user interface enhancements
A number of improvements have been made to the user interface 
as well as steps to increase performance.
 Liquify now runs faster, maybe as much as 16 times faster, when 
working on large documents. Also, zooming in on large documents 
is much faster now and aliasing has been removed when zooming 
levels at in-between full magnification views (i.e. at 33% and 66%).
 Previously, the cursor ring and cross hairs were showing different 
thicknesses in CS6 and this was due to differences in GPU cards. 
This problem has now been ironed out so that cursor rings and 
cross hairs are smoother and thinner, plus the cross hairs are now 
made smaller on the Macintosh interface. You will also notice that 
the Photoshop preferences for cursors now determine the cursor 
appearance in Liquify as well. The brush slider responsiveness is now 
non-linear in behavior. In other words, the slider control feels more 
natural and this is especially noticeable when you use the bracket 
keys ([]) to adjust the cursor size.
 When the Reconstruct tool is selected and you hold down the 
A key this temporarily turns the tool into a new Gaussian Warp 
Smoothing tool. You can use the tool in this mode to smooth out 
ripples in the mesh caused by multiple, small warp tool applications.

On-screen cursor adjustments
Providing you have the OpenGL option enabled in the Photoshop 
Performance preferences, you can now apply on-screen cursor 
adjustments in the Liquify dialog preview. This means that if you hold 
down the LO keys (Mac), or the A key and right-click (PC), 
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dragging to the left makes the brush cursor size smaller and dragging 
to the right, larger (and keeps the cursor position centered as you 
do so). If you drag upwards with these same keys held down you 
can decrease the brush pressure settings and dragging downwards 
will increase the brush pressure (see Figure 4).
 If you hold down the O key the Cancel button changes to 
‘Reset’. But in addition now, if you hold down the C (Mac) L 

(PC) key, the Cancel button changes to ‘Default’, which returns the 
controls to the ‘factory original settings’.

Sticky Tool Settings
Each tool remembers its own settings for size, density, pressure and 
rate. When you switch tools, the new tool remembers its last-used 
settings.

Blur Gallery
Having the ability to apply the Blur Gallery filters to Smart Objects 
opens up a number of interesting opportunities. Primarily, it means 
that you can now apply Blur Gallery filters non-destructively and 
you can easily toggle the smart filter visibility on or off like any 
other smart filter effect. You can combine Blur Gallery filters with 
other filter effects and create different results by placing other filter 
effects above or below the Blur Gallery smart filter. But above all, 
you can now apply Blur Gallery filters as a video layer. This means 
that you can easily apply effects such as a Tilt-Shift Blur filter to any 
video clip to produce the classic miniaturization effect (see page 
16). Note, if you apply a Blur Gallery filter effect to a video layer 
as a smart object and check on the ‘Save Mask to Channels’ option 
this will cause an alpha channel for each video frame to be saved to 
the Channels panel. Photoshop only stores up to 99 channels and 
can therefore soon max out. So be sure to keep the ‘Save Mask to 
Channels’ option unchecked so as to avoid this happening.
 If you apply a Blur Gallery filter to a Smart Object layer with a 
selection active, the filter effect is applied to the whole layer and the 
selection is used to create a smart filter mask (see page 17). It also 
means that the selection bleed effect is fixed at 100% and for this 
reason the Selection bleed setting appears grayed out.
 

Figure 4 In the Liquify dialog, if you hold 
down the LO keys (Mac), or the A 
key and right-click (PC), this reveals the 
on screen cursor display. Drag left/right to 
make the cursor smaller or larger and drag 
up/down to decrease or increase the brush 
pressure setting.
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Applying a Blur Gallery filter to a video clip

1 Here is a frame from a video clip, shot using a regular camera lens. I opened the 
video clip in Photoshop and chose Filter ➯ Convert for Smart Filters.

2 Having converted the opened video file to a Smart Object, I went to the Filter menu 
and Chose Blur ➯ Tilt-Shift… This opened the panels shown here, where I adjusted 
the Tilt-Shift blur effect. In the Layers panel you can see how the Blur Gallery filter has 
been added as a smart filter to the video clip. Then, when finished, use File ➯ Export 
➯ Render Video… to create a video with the effect applied.
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Blur Gallery filter with a smart object plus mask

1 In this example I converted a layer to a Smart Object (Smart Filter) and loaded 
a selection that selected everything but the flower in the foreground. I then went to 
the Filter menu and selected Blur ➯ Tilt-Shift… and applied the settings shown 
here. You will notice that despite the selection being active, the blur filter affected the 
unselected areas as well. In the Options bar the Selection Bleed option was grayed out.

2 After clicking OK in the Options bar to apply the filter the active selection was 
converted into a mask that masked the Smart Filter layer. Unlike in the previous step, 
the unselected areas now appeared unfiltered.
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Crop tool refinements
The aspect ratio controls have been updated in order to address 
some of the confusion over the previous layout design.
 The first thing you will notice is that when the crop tool is 
selected, the crop bounding box does not become visible until after 
you roll the mouse over the document window, which is now less 
distracting I think. The ‘Unconstrained’ option has been removed 
and there is now a clearer indication between the Ratio and the 
W x H x Resolution modes (note you can use the ‘Clear’ button 
to clear all the current fields to quickly get the ‘unconstrained’ 
behavior). You can mouse-down on the menu to select which 
mode you want to use and each of these will remember the last 
used settings. When the W x H x Resolution mode is selected, a 
Resolution field box appears in the Options bar (see Figure 6). The 
Original Ratio option is still there, but has been moved down among 
the factory ratio presets list (see Figure 5).

Figure 5 This shows the CS6 crop tool Options bar (top) and the CS6.1 crop tool 
Options bar (bottom). Note that with CS6.1, ratio presets use ‘:’ as a separator and 
W x H x Resolution presets continue to use x as a separator. There is a new double 
arrow button for switching width and height field settings and the Overlay popup is 
now an iconic fly-out menu. 

Overlay 
popup menu

Clear current 
fields

Double arrow 
button

Original Ratio menu item moved

Front Image option (I)

Save Preset now renamed New Crop Preset…

CS6

CS6.1
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 You will also notice that the swap width and height double arrow 
button has been returned to the crop tool Options bar. This used 
to be there in earlier versions of Photoshop, but got removed in the 
CS6 reorganization for this tool. At the same time the Rotate Crop 
Box button has been removed (see Figure 5). What happens now 
is that, by default, the value entered in the first entry field always 
corresponds to the width and the second value corresponds to the 
height. You then have the option to click on the double arrow button 
to swap these values around as necessary. All in all this refinement 
makes more sense and is easier to get to grips with.
 The ‘Size and Resolution…’ option and corresponding ‘Crop 
Image Size and Resolution’ dialog box is also gone since it is not 
needed now with this redesign of the crop tool Options bar 
interface. New factory presets have been added for the ‘W x H x 
Resolution’ mode as well as an easy to access ‘Front Image’ option 
(the shortcut is now i, it used to be f). Selecting this loads the 
current document full image size dimensions and resolution settings 
(there remains also a Front Image button in the perspective crop 
tool Options bar).

New tool presets
When saving a new crop tool preset the name of the tool (either 
crop tool or perspective crop tool) will be added as a prefix. (see 
Figure 7). 

Figure 7 This shows the New Tool Preset dialog for the crop tool (top) and 
perspective crop tool (bottom).

Figure 6 When the W x H x Resolution mode is selected in Photoshop CS6.1 a 
Resolution field box appears in the crop tool Options bar.
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Conditional Actions
Actions have been around in Photoshop since version 4 of the 
program. Nothing much has been done to improve actions since 
then, other than a recent innovation in CS6, which now allows tool 
recording. When enabled this means you can now record things like 
brush strokes. The CS6.1 update now includes conditional actions, 
which can be inserted into regular actions. 
 Essentially what you can do is create a new action and insert 
a conditional via the Actions panel flyout menu to reveal the 
Conditional Actions dialog shown in Figure 8. From there, you can 
choose a condition from the menu shown in Figure 9 to determine 
which action will be played if this condition is met. If not, you can 
choose an action from the Else menu to play instead. Only actions 
that are included within the current action set will be displayed in 
the ‘Then’ and ‘Else’ pop-ups. Note that if both menus are left set to 

Figure 8 The new Conditional Actions dialog.

Figure 9 The new Conditional Actions dialog showing all the available conditional 
action options.
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‘None’, no conditional action will be created because the resulting 
action would do nothing.
 A conditional action can then be included in batch or droplet 
operations. The following steps show how.

1 I went to the Actions panel, expanded an existing Action set and clicked on the 
Create New Action button to create a new action, called ‘sharpen + convert CMYK’.

2 I then went to the Actions panel flyout menu and selected ‘Insert Conditional…’
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3 My aim here was to create a conditional action that was able to filter out the RGB 
images only to apply a convert from RGB to CMYK action that also included an output 
sharpening step. In the ‘If Current’ menu I selected ‘Document Mode is RGB’. Then, 
from the ‘The Play Action’ menu I selected the appropriate action from the same parent 
Actions folder. I left the ‘Else Play Action’ menu set to ‘None’.

4 Here you can see an expanded view of the Actions panel after creating the above 
conditional action. The action called here was designed to process RGB images only, 
which would otherwise fail to run if applied to an image already in CMYK mode. So, 
by creating the conditional it would only process files in RGB and leave CMYK files 
untouched.
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5 I was not ready to put the conditional action to use. I went to the File menu in 
Photoshop and chose  Automate ➯ Create Droplet… This opened the dialog shown 
here which I configured so that a new droplet was added to a special folder I keep all 
my droplets in and saved the processed files to a destination folder called ‘CMYK’.

6 I clicked OK in the Create Droplet dialog to create the droplet and folder shown here. 
I was now able to test the new droplet. I made a selection of files that were a mixture 
of RGB and CMYK images. I dragged these across to the droplet and Photoshop knew 
to process all the RGB files and ignore the CMYKs. Without a conditional action a 
droplet like this would trip up on the CMYK files and display an alert message asking 
if you wanted to stop or continue. With conditional actions you can avoid distracting 
dialog messages that would otherwise halt an automated batch process.
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HiDPI (Retina displays)
This is something that affects Macintosh users only and even then, 
only those who have upgraded to one of the most recent MacBook 
computers with Retina™ displays. Essentially, a Retina display on 
a Macintosh computer contains twice the usual density of pixels. 
This gives the user the option of doubling the pixel resolution of 
the display, but at the expense of everything appearing tiny on 
the screen (especially user interface designs). But there are other 
configurations available that you can configure in the Macintosh 
system preferences. If you choose not to double the pixel resolution 
you will still ideally want the software you use on that computer to 
be Retina display enabled, where the user interface (UI) icons are 
designed at twice the usual resolution. This will result in a smoother 
UI appearance. 
 With an image editing program such as Photoshop, the Retina 
display throws something of a curve ball. How should Photoshop 
images be displayed? Do you want them to be displayed at the 
native pixel resolution of the Retina display device where one 
Photoshop image pixel is displayed using one Retina display pixel. 
Or, do you want the image magnification set so that one Photoshop 
image pixel is displayed using 4 Retina display pixels? Add to this 
the fact that we have people on Retina displays who are designing 
images for non-retina displays and vice versa. Therefore, extra 
controls are required to manage the difference between what is 
seen and what is perceived. Plus, we now have to think carefully 
when we talk about pixel sizes, since in the context of a Retina 
display this can now mean different things.

Retina display and default zoom settings
When a Retina display is set to a pixel resolution where four Retina 
display pixels equals one display pixel, the default behavior is to open 
images in Photoshop such that one Retina display pixel equals one 
Photoshop pixel. However, when opening smaller images this may 
mean them appearing really tiny on the screen. The initial image 
opening zoom rate used to default to 100% and where the image 
document was unable to fit in the document window, the zoom rate 
was decreased until it was able to fit within a document window 
that filled the screen. The initial image zoom opening has now been 
revised to 400%. Therefore, image files with small pixel dimensions 
will now be displayed much bigger than was the case previously.
 If you are working with a Retina display, your images may be 
displayed at a much finer resolution than was the case previously 
and you may wish to quickly change the zoom setting so that four 

Sidebar

There are implications for web design 
layouts. Do you need to incorporate dual 
resolutions for people visiting a website 
where a Retina display is detected? I am 
aware of conversations where such a 
strategy has been proposed. This might 
possibly be important for photographers 
wishing their portfolio pages to be viewed 
as optimally as possible.
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Retina pixels equal a single Photoshop pixel. In other words, have 
a means to quickly switch to a 200% view setting instead of 100%. 
You can use a C (Mac) L (PC) double-click on the zoom tool 
to zoom a document to a 200% view. You can use a CS (Mac) 
LS (PC) + double-click on the zoom tool to set all open 
documents to a 200% view. Whenever the hand or zoom tool are 
active you will notice that the context menu now includes a 200% 
view option (see Figure 10) and in the Options bar the Actual Pixels 
button has been renamed ‘100%’ so as to avoid any confusion (see 
Figure 11). Lastly, there is now a 200% option in the View menu and 
you can also assign this with a custom keyboard shortcut should you 
wish.

Figure 10 The zoom tool context menu 
has been changed in CS6.1. Instead of an 
Actual Pixels item it now includes 100% 
and 200% zoom options. Note also that the 
Print Size menu item has been removed

The future of Retina displays
For now, retina displays are only available to a niche sector of the 
market. There are certainly fewer Macintosh than PC users and of 
those who do use a Mac, only those who have purchased a new 
MacBook Pro computer in the latter half of 2012 or later will have a 
retinized display to work with. That being said, Apple may be in the 
lead here coming up with a high density display and PC operating 
systems may too need to accommodate such displays. So while only 
a few people may be affected by this news for now, I would expect 
this technology to become more commonplace in the future.

Big JPEG
Previous versions of Photoshop were limited to a maximum of 
30,000 pixels. However, Photoshop is now able to open and save 
JPEG documents up to 65,535 pixels in width or height.

Figure 11 This shows the Photoshop CS6 crop tool Options bar (top) and the new 
CS6.1 Options bar (bottom). Here, the ‘Actual Pixels’ button has been replaced by a 
‘100%’ button. As mentioned already, the Print Size item has also been removed.

CS6

CS6

CS6.1

CS6.1
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Load/Replace Swatches from HTML
From the Swatches panel it is now possible to load swatches from 
an HTML page you are working on. As shown here, you use the 
Swatches panel menu to select the Load Swatches… or Replace 
Swatches… menu item and then select an HTML document to 
read from (this option is also available via other swatch pickers). 
This option will read color swatches from HTML, CSS and SVG files. 
It only loads colors that are unique to a document as opposed to 
every instance a color appears in a document.
 The main benefit of this feature is that when working on a web 
page design you can now efficiently import precise HTML colors 
into Photoshop.

Sidebar

This feature recognizes HTML/CSS 
color syntax: #112233 #123 rgb(1,2,3) 
rgba(1,2,3,4) hsb(1,2,3) and hsba(1,2,3,4).

1 Here is a web page that I created in Adobe Dreamweaver and is saved as an HTML 
file.

2 In Photoshop, I went to the Swatches panel, moused down to reveal the panel 
options menu (circled) and chose Load Swatches…
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Hex Field
When working in RGB mode, the Color picker, the Hex Field is now 
selected by default (see Figure 12).

3 I then navigated to select the HTML document that was shown open in step 1.

4 This then added two colors from the web page design to the Swatches panel.
 

Figure 12 The Color Picker dialog with the Hex field auto-selected. 


